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Abstract 

Tissue engineering by self-assembly allows for the fabrication of living tissue surrogates by taking 

advantage of the cell’s inherent ability to produce and deposit tissue-specific extracellular matrix. 

However, the long culture periods required to build a tissue substitute in conducive to phenotypic 

drift in vitro microenvironments result in phenotype and function losses. Although several 

biophysical microenvironmental modulators (e.g. surface topography, substrate stiffness, 

mechanical stimulation) have been used to address these issues, slow extracellular matrix deposition 

remains a limiting factor in clinical translation and commercialisation of such therapies. 

Macromolecular crowding is an alternative in vitro microenvironment modulator that has been 

shown to accelerate extracellular matrix deposition by several orders of magnitude, thereby 

decreasing culture periods required for the development of an implantable device, whilst 

maintaining cell phenotype and function. Herein, we provide protocols for the production of rich in 

extracellular matrix tissue surrogates from human dermal fibroblasts, equine tenocytes and equine 

adipose derived stem cells using the principles of macromolecular crowding and the subsequent 

characterisation thereof by means of immunofluorescent staining and complementary fluorescence 

intensity analysis. 
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1. Introduction 

Modern tissue engineering capitalises the inherent capacity of cells to create native supramolecular 

assemblies. However, during in vitro expansion, deprived of their optimal tissue context, cells lose 

their phenotype and function. To overcome such issues, numerous in vitro microenvironments 

modulators, including surface topography, substrate elasticity, mechanical loading, are at the 

forefront of scientific research and technological innovation [1]. The fabrication of native 

supramolecular assemblies, or tissue surrogates, is highly dependent on the rate of deposition of 

extracellular matrix (ECM) which, under traditional cell culture conditions, is extremely slow due 

to the very dilute culture conditions [2]. Macromolecular crowding (MMC) has been proposed as an 

efficient method to not only enhance ECM deposition, but to also maintain their phenotype during 

in vitro culture [3]. MMC is a biophysical phenomenon that enhances thermodynamic activities and 

biological processes by several orders of magnitude [4, 5]. It is based on the addition of inert 

macromolecules to the culture media and it acts by recreating the highly confined or crowded in 

vivo environment [2]. Several molecules have been tested as macromolecular crowders, including 

dextran sulphate, Ficoll™, polyethylene glycol, polyvinylpyrrolidone and carrageenan [6-10]. 

Among them, carrageenan, a highly sulphated polysaccharide, has been shown to induce maximum 

ECM deposition in permanently differentiated and stem cell cultures due to its higher polydispersity 

/ more effective excluding volume effect [3, 6, 11-16].	

Immunofluorescent labelling techniques are a very valuable tool for in situ identification of a wide 

variety of biological molecules. This identification can be performed directly, by means of the use 

of a primary antibody against the molecule of interest labelled with a fluorochrome [17, 18], or 

indirectly, by utilising a primary antibody against the molecule of interest and a fluorescently-

labelled secondary antibody that targets specifically the primary antibody [19]. By using different 

combinations of primary and secondary antibodies conjugated with different fluorochromes, the 

spatial relations of two or three different molecules can be assessed simultaneously in one sample 
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[20]. In addition, with the aid of a fluorescence microscope connected to a camera and publicly 

available software, a semi-quantitative analysis can be performed in order to estimate the relative 

amounts of antigen that are present in different samples, thereby increasing the value of such 

techniques. Herein, we describe protocols for the fabrication of rich in ECM tissue surrogates from 

human dermal fibroblasts, equine tenocytes and equine adipose derived stem cells using the 

principles of MMC and the subsequent characterisation thereof by means of immunofluorescent 

staining and complementary fluorescence intensity measurements. 

 

2. Materials 

All cell culture materials should be handled following aseptic technique. Human primary cells 

should be handled using Biosafety Level 2 practices and containment. Diligently follow all the 

waste disposal regulations of your country / institution when disposing any kind of waste material. 

 

2.1 Cell Culture 

1. Human normal adult dermal fibroblasts (hDFs), cryopreserved (ATCC). 

2. Equine tenocytes (eTCs), cryopreserved. 

3. Equine adipose derived stem cells (eADSCs), cryopreserved. 

4. Dulbecco’s modified Eagle’s medium, high glucose (DMEM). 

5. Foetal bovine serum (FBS). 

6. Penicillin-streptomycin solution 100× (PS). 

7. Growth medium: Prepare growth medium by adding 10 % FBS and 1 % PS solution to the 

appropriated volume of DMEM. 

8. Trypsin-EDTA solution. 

9. Hank’s balanced salts solution 10× (HBSS) without Ca2+ and Mg2+. 

10. Double distilled water, sterile. 

11. Carrageenan powder, suitable for gel preparation. 
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12. 100 mM L-ascorbic acid 2-phosphate solution. Prepare a stock solution of 100 mM L-

ascorbic acid 2-phosphate in ddH2O and sterile-filter with a syringe and a 0.2 µm syringe 

filter. Store it in frozen aliquots at -20 ºC and protect it from the light. 

13. 0.2 µm surfactant free cellulose acetate sterile syringe filters. 

14. 10 mL luer lock sterile syringes. 

15. 75 cm2 tissue culture flasks. 

16. 48-well tissue culture plates. 

17. MMC growth medium: weigh the appropriated amount of carrageenan powder in a 1.5 mL 

microcentrifuge tube in order to prepare 0.5 mL of medium per well to be treated, considering 

a concentration of carrageenan of 75 µg/mL (the concentration may need to be optimised for 

the cell population of interest). Always prepare 2 mL extra in order to compensate for 

pipetting errors. In order to disinfect the carrageenan, irradiate it with UV-C light for 15 

minutes (see Note 1). Supplement growth medium with 1 µL of the 100 mM ascorbic acid 

solution per mL of medium in order to reach a concentration of 100 µM. This will be used as 

the control medium and will also be used to prepare MMC growth medium by adding 

carrageenan. For the preparation of MMC growth medium, recover the disinfected 

carrageenan from the 1.5 mL microcentrifuge tube by suspending it in 1 mL of growth 

medium supplemented with ascorbic acid and transfer the volume to a tube with the 

remaining medium. Repeat this step at least twice in order to ensure the complete recovery of 

the carrageenan from the tube. For non-crowded control wells, keep aside the appropriated 

volume of growth medium supplemented with L-ascorbic acid 2-phosphate for this purpose 

(0.5 mL per well + 2 mL extra for compensating pipetting errors). For the solubilisation of the 

carrageenan in the growth medium supplemented with ascorbic acid, incubate the tube in a 

thermostatic bath at 37 ºC for at least 30 minutes (see Note 2). 
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2.2 Immunofluorescent characterisation of the ECM 

1. Phosphate buffered saline (PBS): 137 mM sodium chloride, 2.7 mM potassium chloride, and 

10 mM phosphate buffer. Add 8 g of NaCl, 0.2 g of KCl, 1.44 g of Na2HPO4 and 0.24 g of 

KH2PO4 to 800 mL of dH2O. Adjust the pH to 7.4 with HCl before adding dH2O to 1L. 

2. Fixing solution: paraformaldehyde (PFA) 2% (w/v) in PBS. Weight 0.2 g of PFA 95% 

powder and dissolve it by heating and stirring in a glass beaker containing 10 mL of 1x PBS 

(see Note 3). Allow dissolution for 1 hour (see Note 4). Once the PFA has been completely 

dissolved, transfer the resulting fixation solution to a 50 mL centrifuge tube. Store at 4°C. 

Filter the solution through a 0.2 µm sterile syringe filter before use. 

3. Blocking solution: 3% bovine serum albumin (BSA) in PBS. Weight 0.3 g of bovine serum 

albumin and dissolve it in 10 mL of 1x PBS in a 15 mL centrifuge tube by vortexing. Keep it 

at 4°C for short term or -20°C for long-term storage. 

4. Primary antibodies (Abcam): mouse monoclonal anti-collagen type I (ab90395), rabbit 

polyclonal anti-collagen type III (ab7778), rabbit polyclonal anti-collagen type IV (ab6586), 

rabbit polyclonal anti-collagen type V (ab7046), rabbit polyclonal anti-collagen type VI 

(ab6588), rabbit polyclonal anti-fibronectin (ab2413) (see Note 5). Prepare the dilutions of the 

primary antibodies in 1× PBS as indicated: mouse monoclonal anti-collagen type I (1:200), 

rabbit polyclonal anti-collagen type III (1:200), rabbit polyclonal anti-collagen type IV 

(1:200), rabbit polyclonal anti-collagen type V (1:200), rabbit polyclonal anti-collagen type 

VI (1:200), rabbit polyclonal anti-fibronectin (1:200). 

5. Secondary antibodies (ThermoFisher): goat anti-rabbit conjugated to AlexaFluor®488 (A-

32731), goat anti-mouse conjugated to AlexaFluor®555 (A-32727) (see Note 6). Prepare the 

dilutions of the secondary antibodies in 1× PBS as indicated: goat anti-mouse 

AlexaFluor®555 (1:500) for collagen type I immunofluorescent staining; goat anti-rabbit 

AlexaFluor®488 (1:500) for collagen types III, IV, V, VI and fibronectin immunofluorescent 

staining. Protect them from exposure to light (see Note 7). 
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6. DAPI solution: weight 1 mg/mL of DAPI and dissolve it in ddH2O to produce a 2000× 

solution. Dilute with methanol to obtain the 1x solution. 

7. Mounting medium (Vectashield). 

8. 8mm Ø round glass cover slips. 

 

2.3 Fluorescence intensity measurements 

1. Inverted fluorescence microscope, equipped with 20× objective, filters suitable for DAPI 

(Ex/Em: 358⁄ 461 nm), AlexaFluor®488 (Ex/Em: 495/519 nm), AlexaFluor®555 (Ex/Em: 

555/565 nm) and a connected camera. 

2. Q-Capture Pro 7 software for image acquisition or similar. 

3. ImageJ (version: 1.51j8) software. 

 

3. Methods 

For the preparation of the rich in ECM tissue surrogates, routine cell culture practices should be 

applied. 

 

3.1 Preparation of rich in ECM tissue surrogates 

1. Fill the appropriated number of 75 cm2 tissue culture flasks (T75) with 12 mL of growth 

medium. Equilibrate the flasks for 30 minutes in a cell culture incubator at 37 ºC and 5 % 

CO2. 

2. Thaw a vial of cryopreserved hDFs, eTCs, eADSCs, low passage preferred (see Note 8) in a 

thermostatic bath at 37 ºC and seed the pre-equilibrated tissue culture flasks at 2,500 cells per 

cm2 for the hDFs or 5,000 cells per cm2 for the eTCs and eADSCs. Incubate the cells 

overnight at 37 ºC and 5 % CO2 under humidified atmosphere and replace the medium with 

12 mL of fresh growth medium per T75 flask. Replace the growth medium every 3 - 4 days. 
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3. Once the cell cultures have reached approximately 85 % confluency, discard the growth 

medium and wash the cell layers twice with 5 mL of 1× HBSS per T75 flask. Discard the 

HBSS and add 2 mL of trypsin-EDTA solution to each flask and incubate 5 minutes at 37 ºC. 

Assess cell detachment by microscopical examination and once all cells are detached from the 

flasks, add 4 mL of growth media, collect the cell suspension and centrifuge it for 5 minutes 

at 400g, 700g or 1200g for the hDFs, eADSCs, and eTCs, respectively. Discard the 

supernatant and resuspend the cell pellet in 1 mL of growth medium per every cultured T75. 

Determine the cell concentration with the aid of a haematocytometer or similar. 

4. To plate the desired number of wells in 48-well tissue culture plates, adjust cell concentration 

in order to seed 25,000 cells per cm2 for the hDFs and eTCs and 15,000 cells per cm2 for the 

eADSCs and ensure that each well has 0.5 mL of growth medium and incubate the plates at 

37 ºC and 5 % of CO2. In order to appreciate the effects of MMC on ECM deposition, at least 

three wells are used per immunofluorescence marker to be analysed, and three wells without 

macromolecular crowder are used as control group. Plate the necessary number of wells per 

immunofluorescence assay in duplicate in order to have non-primary antibody controls in 

triplicate per condition. 

5. After 24 hours of culture, examine the cells by microscopy and ensure that they are healthy 

and properly attached to the cell culture substrate before replacing the medium. 

6. Replace the medium of the wells to be treated with MMC medium with 0.5 mL of the growth 

medium containing ascorbic acid and carrageenan or only ascorbic acid for control wells. 

Incubate the plates at 37 ºC and 5 % CO2. 

7. After 3 days of culture, the plates can be examined by microscopy and processed for 

immunofluorescent staining. 

 

3.2 Immunofluorescent characterisation of the ECM 

All the following steps must be performed at room temperature (unless otherwise stated). 
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1. At the end of every time point, aspirate the cell culture media of the corresponding plate and 

wash every well three times during 5 minutes with 500 µL of 1× sterile HBSS. Fix the 

samples with 150 µL/well of the filtered fixation solution pre-cooled at 4°C for 15 minutes 

(see Note 9). 

2. Remove the fixation solution and wash the wells three times during 5 minutes with 250µL of 

1× PBS. Samples can be kept at 4 ºC in 1x PBS if immunofluorescent staining is not to be 

performed right away.  

3. Add 150 µL per well of BSA blocking solution for 30 minutes to block unspecific binding 

sites for the primary antibody. 

4. After the aforementioned 30 minutes, drain the blocking solution and incubate the samples 

with 75 µL per well of the corresponding primary antibody solution for 90 minutes. For 

negative control wells, add 75 µL of 1× PBS per well (see Note 10). 

5. Remove the primary antibody solution and wash the wells three times during 5 minutes with 

250µL of 1× PBS (see Note 11). Incubate with 75 µL per well of the corresponding secondary 

antibody solution for 30 minutes. In this case, all the samples including the negative controls 

must be incubated with the corresponding secondary antibody solution (see Note 12). Protect 

the samples from light from here on.  

6. Remove the secondary antibody solution and wash three times during 5 minutes with 250µL 

of 1x PBS.  

7. Remove the PBS and incubate the samples 5 minutes with 75µL per well of 1× DAPI solution 

in order to stain nuclei. 

8. Remove the DAPI solution and wash three times during 5 minutes with 250µL of 1× PBS. 

9. Add 10 µL per well of VECTASHIELD® mounting media and place a cover slip in each well 

(see Note 13). 

10. Analyse the samples by using ultraviolet excitation filter (e.g. Ex: 360-370 nm / Em: 420-460 

nm) to visualize cell nuclei stained with DAPI, a blue excitation filter (e.g. Ex: 460-495 nm / 
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Em: 510-550 nm) to visualize collagen types III, IV, V, VI and fibronectin stained with 

AlexaFluor® 488 and finally, a green excitation filter (e.g. Ex: 535-555 nm / Em: 570-625 

nm) to visualise collagen type I stained with AlexaFluor®555 (Figure 1). 

 

3.3 Imaging and quantification of immunofluorescent staining 

Perform the steps relative to the image acquisition process in dark, in order to prevent the loss of 

fluorescence intensity from the fluorophores as a consequence of light excitation. 

1. Once the software has been launched, position the plate on the sample stage of the microscope 

and visualize a live preview from the camera input: be sure that the light path selector of the 

microscope is set on “camera” to view the image on screen. 

2. It is pivotal to keep the same exposure time for all the samples examined for the same antigen 

(see Note 14). Adjust the exposure time for DAPI, and carefully adjust the focus on the cell 

layer. Select the correct filter to excite the fluorophore bound to the secondary antibody of 

interest, regulate the exposure time in order to avoid saturation, and take note of the longest 

exposure time void of saturation. Repeat these actions for all the samples, excluding the 

negative controls, then set the lowest obtained exposure time value to examine all of the 

samples and controls. 

3. Position the plate on the sample stage exposing the first sample to the light path, select the 

violet filter and acquire a 20× magnified picture of the nuclei stained with DAPI. Without 

moving the sample, turn the filter block turret to the appropriated filter for the fluorophore 

bound to the secondary antibody of interest, regulate the focus and acquire the image. Repeat 

this step five times in randomly selected fields of the well for each replicate of each condition. 

4. Using the emission filter for the secondary antibody of interest, acquire five pictures from five 

randomly selected fields of the non-primary antibody negative controls (see Note 15). Save 

all the acquired pictures in TIFF format before proceeding with the analysis of fluorescence 

intensity, which can be performed with the ImageJ software. 
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5. To proceed with the analysis, open the desired picture with the ImageJ software, open the 

“Analyze” menu, click on “Set measurement”, tick “Mean grey value” option, then “OK”. 

Open again the “Analyze” menu and this time click on “Measure”: a results window will 

appear. Repeat this step for all the pictures of the replicate in examination and transfer the 

data to an Excel worksheet to further process them. Repeat this step for all the replicates of all 

the examined conditions, including the non-primary antibody negative controls. 

6. By using Excel average function, obtain the average of the mean grey values for each 

replicate, including negative controls, and then subtract the negative control mean value to 

each corresponding replicate to obtain their specific fluorescence intensity (see Note 16). 

7. Calculate the average and standard deviation of each condition from the values of the 

corresponding replicates for further statistical analysis and graphical representations (Figure 

2). 

8. To create a representative picture of the assay, open the desired image in ImageJ software 

together with the corresponding DAPI field. For both of the pictures, open the ‘Image’ menu, 

select ‘Type’ and click on’32-bit’. Once all the images that need to be merged in a single 

picture have been turned to 32-bit format, open the ‘Image’ menu, select ‘Colour’, then 

‘Merge channels’: match each picture with the desired channel, tick the ‘create composite’ 

box and click ‘Ok’ to obtain the composite picture (see Note 17). Once the picture has been 

saved in the preferred format, it is possible to add a scale bar using the dedicated Image J tool 

(see Note 18). 

 

4. Notes 

1. The efficacy of UV-C disinfection depends on many parameters, as are the intensity and 

wavelength of the UV radiation, the time of exposure, the distance from the source of 

irradiation, the presence of particles that can protect the microorganisms from UV, and a 

microorganism’s ability to withstand UV during its exposure. We currently disinfect the 
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carrageenan with success inside of an open 1.5 mL microcentrifuge tube in vertical position 

with the UV lamps typically included in the biological safety cabinets used for cell culture, 

but more dedicated equipment can be also used with the same efficacy if similar conditions 

are met. 

2. Once the carrageenan is suspended into the medium, if the tube is vortexed and observed 

through a light source, particles in suspension can be appreciated. Once the carrageenan is 

completely dissolved into the medium, no particles can be appreciated following the same 

observation procedure. Is very important to ensure the completely dissolution of the 

carrageenan into the medium as non-dissolved particles can deposit on the bottom of the 

plates and negatively affect the cell viability. 

3. Avoid temperatures over 60 °C (optimal are between 55 – 57 ºC), which result in methanol 

formation and the reduction of the effective concentration of PFA. This can damage the 

cytoskeleton of the cells and increase the auto-fluorescence of the samples. 

4. For safety reasons, make the fixation solution under a chemical hood and cover the glass 

beaker, with aluminium foil for example, to prevent the release of PFA toxic vapours and the 

evaporation of the PFA. Likewise, all the steps that involve the use of the fixation solution 

must be executed under a chemical hood due to the PFA toxicity. 

5. To perform the localisation of several molecules in the same sample by indirect 

immunofluorescent staining, it is required for the primary antibodies against the antigens of 

interest to be raised in different species in order to be able to be recognised by different 

specific secondary antibodies (e.g. the primary antibody anti-collagen type I has been raised 

in mouse and can be combined with any of the other primary antibodies raised in rabbit for 

their use in multicolour immunostaining). 

6. For the selection of the secondary antibodies, several guidelines must be followed. First, the 

secondary antibody must be specific for the target species corresponding to the primary 

antibody (e.g. goat anti-mouse secondary antibodies for primary antibodies derived from mice 
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and goat anti-rabbit secondary antibodies for primary antibodies derived from rabbit). 

Moreover, to avoid cross-reactivity with the non-intended primary antibody targets in 

multicolour immunostaining and increase specificity, secondary antibodies cross-adsorbed 

against IgGs from the non-target species and sera from different species can be used (e.g. for 

the present study, we used goat anti-mouse secondary antibody cross-adsorbed against human 

serum and rabbit and goat IgGs, as well as goat anti-rabbit secondary antibody cross-adsorbed 

against mouse and goat IgGs). The selection of the fluorochromes conjugated with the 

secondary antibodies and the appropriated filter set it is crucial to have the minimal signal 

overlapping and maximal specificity in case of detecting several molecules at the same time 

in multicolour immunofluorescent stainings. For this, it is very important to excite each 

fluorochrome with wavelengths as close as possible to its maximal excitation, avoiding at the 

same time to excite the other fluorochromes present in the sample. Also, for collecting the 

fluorescence of each fluorochrome specifically, the emission filter should match as close as 

possible the maximal emission wavelength of the corresponding fluorochrome, avoiding at 

the same time the emission of the other fluorochromes present in the sample. As an example, 

the filter set distribution and fluorochromes selected for the present study is shown in Figure 

3. 

7. Protect the samples from the light to avoid the loss of fluorescent signal due to 

photobleaching. The photobleaching effect (also termed as fading) causes a permanent 

photochemical alteration, by cleaving covalent bonds in the fluorochromes. These irreversible 

modifications make the fluorochrome unable to emit fluorescence and thereby decrease the 

signal in the samples. 

8.  (a) The hDFs that can be acquired from ATCC are generally in early passages (p0 - p1). In 

order to expand them, before the preparation of the tissue surrogate, a cell density of 2,500 

cells per cm2 in growth medium was used. The subculture routine included 2 × 5 min washes 

with 5 mL of 1× HBSS, 2 mL of trypsin-EDTA solution for 5 minutes at 37 ºC, cell recovery 



16 
 

with 4 mL of growth medium per each T75 flask, centrifugation for 5 minutes at 400 g, 

resuspension, counting and plating at 2500 cells per cm2. Normally, the cells reach confluency 

after a week of culture, and medium is changed twice per week, using 12 mL per T75. For cell 

cryopreservation, a cell density of 500,000 cells / mL of 10 % DMSO in FBS was used. (b) 

The eTCs used for this experiment were isolated by migration method from superficial digital 

flexor tendon of equine donors after surgical removal of the paratenon. Expansion in culture 

was performed using a seeding density of 5,000 cells per cm2. Subculture was performed as 

for the case of the hDFs, except for the centrifugation of the cell suspension, which was 

performed at 1,200 g, and for a centrifugation step which was added in the thawing procedure 

in order to remove DMSO traces before plating. For cell cryopreservation, a cell density of 

1,000,000 cells per ml of 10 % DMSO in FBS was used. (c) eADSCs were extracted by 

collagenase type I digestion from fat samples of the mane of 4 horses. eADSC subcultures 

were performed at 5,000 cells per cm2 following the same procedure as for the hDFs, except 

for the centrifugation step at 700 g for 6 minutes. For cell cryopreservation, a cell density of 

1.8-2 x 106 cells per mL of 10 % DMSO in FBS was used. 

9. Be extremely careful during fixation and washing steps to prevent the detachment of the cell 

layer. 

10. Alternatively, incubation with the primary antibody solutions can be performed overnight at 4 

°C. 

11. When working with a high number of experimental groups or samples, always proceed with 

the washes in a fractional way in order to avoid drying the samples. Drying may cause a 

background increase due to unspecific binding of the primary antibody to the sample. 

12. In order to demonstrate the non-specific binding of the secondary antibodies to the sample, 

the non-primary antibody control wells should be incubated with the corresponding secondary 

antibody solution. For multicolour immunostaining, these wells should be incubated with a 

solution containing the mixed secondary antibodies as applied to the sample wells. 
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13. Be extremely careful when placing the cover slips. Introduce them vertically in one edge of 

the well and leave them fall slowly in order not to form bubbles and not damage the cell layer. 

Do not press them forcefully once properly positioned, as this can cause the loss of the 

sample. 

14. The selection of an optimal exposure time suitable for all the examined samples, defined as 

the maximal exposure time at which the sample with the highest fluorescence intensity does 

not show signs of saturation, will allow for the comparison of the collected data between the 

different samples. The acquisition of an excessively saturated image would result in an 

underestimation of fluorescence intensity. 

15. Background fluorescence can result from several factors, such as non-specific binding of the 

secondary antibodies, or auto-fluorescence from the culture plate, the cultured cells and from 

collagen itself. The quantification of non-primary antibody controls fluorescence is therefore 

performed in order to estimate the amount of this non-specific fluorescence, which will 

eventually be subtracted from the mean grey value measurements of the corresponding 

samples. 

16. In order to proceed with further statistical analysis, values from each of the single replicates 

are needed. Therefore, subtract to the value of each replicate of the condition in analysis, the 

mean value obtained from all the three replicates of the corresponding non-primary antibody 

control. 

17. It is possible to merge more than two pictures, or channels, in this step, in order to appreciate 

the relative localisation of the examined antigens. To reduce the background interference that 

can derive from non-specific binding of the antibodies as well as from autofluorescence of 

several biological molecules, or even from the plastic substrate, the ‘Subtract background’ 

Image J tool can be useful. To use it, right after the images have been turned to 32-bit format, 

open the ‘Process’ menu, click on ‘Subtract background’, select the same rolling ball radius 

for every picture in the assay and confirm with ‘OK’, then proceed with the merging of the 
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channels. Choose a larger rolling ball radius to maximise the preservation of positive pixels 

intensity, or a smaller one to maximise background subtraction. 

18. There are several options to add a scale bar with ImageJ. If the pixel/length ratio is known, it 

is possible to open the ‘Analyze’ menu, select ‘Set scale’, type ‘1’ in the ‘Pixels’ box and type 

the corresponding distance in the ‘Known distance’ box, then specify the unit of length and 

confirm with ‘OK’. If the pixel/length ratio is not known, it is possible to use the ‘Straight’ 

tool from Image J toolbar in order to trace a segmented line covering a known distance in the 

picture, then open the ‘Set scale’ window and fill the ‘Known distance’ and ‘unit of length’ 

boxes, then confirm with ‘OK’. A third option provides that a second picture, with the same 

pixel/length ratio of the former and already containing its scale bar is open and selected in 

Image J: in such case, it is only needed to tick the ‘Global’ box in the ‘Set scale’ window 

before clicking ‘OK’ to apply the same scale to all the open pictures. To finally add the scale 

bar to the desired picture, all the listed options provide that the ‘Analyze’ menu is open, in 

order to select ‘Tools > Scale bar’, personalize the scale bar and confirm with ‘OK’. 
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6. Figures 

 

Figure 1: Immunofluorescent labelling of different extracellular matrix proteins in hDFs, eTCs and 

eADSCs after 3 days in the presence (CR+) or absence (CR-) of macromolecular crowding 

(carrageenan). Macromolecular crowding increases deposition of matrix proteins in a cell type-

dependent fashion. 
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Figure 2: Fluorescence intensity analysis of different extracellular matrix proteins in hDFs, eTCs 

and eADSCs after 3 days in the presence (CR+) or absence (CR-) of macromolecular crowding 

(carrageenan). Fluorescence intensity provides an estimation of the relative amounts of the different 

extracellular matrix proteins produced by the different cell types in the presence or absence of 

macromolecular crowding. 
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Figure 3: Fluorescence spectra of the different fluorochromes used and filter set distribution. 

Excitation (dashed line) and emission (continuous line) spectra and filter set used for DAPI (ex1: 

350/10; em1: 440/20) (A), Alexa® 488 (ex2: 478/18; em2: 530/20) (B), Alexa® 555 (ex3: 545/10 

and em3: 598/28) (C) and all the fluorochromes together (D). Minimal spectral overlapping can be 

appreciated when using the present filter set and fluorochromes selection. 
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